CHAPTER 1

Getting to Know AutoCAD

- Opening a new drawing
- Getting familiar with the AutoCAD and AutoCAD LT graphics windows
- Modifying the display
- Displaying and arranging toolbars
Your introduction to AutoCAD and AutoCAD LT begins with a tour of the user interface of the two programs. In this chapter, you’ll also learn how to use some tools that help you control the interface’s appearance and how to find and start commands. For the material covered in this chapter, the two applications are almost identical in appearance. Therefore, as you tour AutoCAD, I’ll point out any differences between AutoCAD and AutoCAD LT. In general, LT is a 2D program, so it doesn’t have most of the 3D features that come with AutoCAD, such as solids modeling and rendering. The AutoLISP programming language found in AutoCAD is also absent from LT. The other differences are minor. As mentioned in this book’s introduction, when I say AutoCAD, I mean both AutoCAD and AutoCAD LT. I’ll also refer to AutoCAD LT as LT throughout this chapter and the rest of the book to specifically refer to that version. Starting AutoCAD is the first task at hand.

Starting AutoCAD

If you installed AutoCAD using the default settings for the location of the program files, start the program by choosing Start ➞ Programs ➞ Autodesk ➞ AutoCAD 2008 ➞ AutoCAD 2008 or by choosing Start ➞ All Programs ➞ Autodesk ➞ AutoCAD LT 2008 ➞ AutoCAD LT 2008, depending on your program. (This command path might vary depending on the Windows scheme you are using.) If you customized your installation, find and click the AutoCAD 2008 icon or the AutoCAD LT 2008 icon on your desktop.

Exploring the New Features Workshop

The New Features Workshop dialog welcome screen opens when you first start AutoCAD and leads to several animated demonstrations and explanations of the new features included in the latest release of AutoCAD (see Figure 1.1). This is a quick and easy way to see how AutoCAD 2008 has improved over AutoCAD 2007 and which tools you can use to augment any skills you already have. Choosing Maybe Later on the left side of the dialog box causes it to reappear every time you start AutoCAD; choosing the No, Don’t Show This to Me Again option dismisses the dialog box indefinitely. You must then access the New Features Workshop through the Help menu in the menu bar at the top of the AutoCAD user interface. Selecting the Yes radio button on the left side of the dialog box opens the New Features Workshop dialog box (see Figure 1.2). Here, you navigate and select the feature you want to investigate in the left pane and observe the selection in the right pane. The drop-down list in the upper-left corner provides access to the New Features Workshops for other Autodesk products installed on your system.
New Features Workshop

The New Features Workshop is a series of interactive animations, tutorials, and short descriptions designed to help you learn the new features.

Would you like to view the New Features Workshop now?

- Yes
- Maybe later
- No, don’t show me this again

You can also access the New Features Workshop from the Help menu.

Figure 1.1: The AutoCAD welcome screen provides access to the New Features Workshop.

Figure 1.2: The New Features Workshop dialog box
The Customer Involvement Program

Nearly all the latest releases of Autodesk products include the opportunity to participate in the customer involvement program (CIP). The CIP is designed to collect nonpersonal information about your Autodesk products and computer system to help the product programmers and developers design software that best meets their customers’ needs. If you haven’t yet agreed or disagreed to participate, when you first start AutoCAD, you might be prompted to join with the Customer Involvement Program dialog box.

Participation is strictly voluntary, and if you choose to participate, AutoCAD will periodically send a small file to Autodesk containing information such as your software name and version, the commands you use, and your system configuration information. An Internet connection is required, and you must ensure that your firewall settings don’t prevent the information from being transmitted.

Exploring the AutoCAD User Interface

After bypassing the initial dialog boxes that AutoCAD provides, the program opens to display the AutoCAD user interface, also called the graphics window. AutoCAD provides many methods for creating and editing objects, changing the view of a drawing, or executing AutoCAD file maintenance or other utilities. In LT, your screen looks similar to Figure 1.3. For AutoCAD, your monitor displays one of three workspaces: the AutoCAD Classic workspace (also similar to Figure 1.3); the 3D Modeling workspace (see Figure 1.4); or the 2D Drafting & Annotation workspace, which is similar to the AutoCAD Classic workspace. You’ll be using a variation of the AutoCAD Classic workspace for the first 14 chapters in this book. In the final two chapters, you’ll switch to the 3D Modeling workspace, but for now, you need to get your AutoCAD user interface to look like Figure 1.3.

**NOTE** The figures and graphics in this book show the drawing area of the AutoCAD user interface with a white background, but the default, and preferred, method is to use a black background to reduce eyestrain. The color choice in the book is simply for readability.
FIGURE 1.3: The AutoCAD graphics window using the AutoCAD Classic workspace

FIGURE 1.4: The AutoCAD graphics window using the 3D Modeling workspace
The toolbars on your screen might not be in the same places as they are shown here. Later in this chapter, you’ll see how to move the toolbars, display and place new toolbars, and suppress the toolbars. If your screen looks like Figure 1.4 or isn’t at all like Figure 1.3, you need to make a few changes:

1. Click the drop-down arrow in the Workspaces toolbar, and choose AutoCAD Classic. Alternately, you can choose Tools ➣ Workspaces ➣ AutoCAD Classic. (If AutoCAD Classic already has a check in the box next to it or if you are using LT, this step is unnecessary.)

2. By default, the AutoCAD Classic workspace displays the tool palettes on the screen. If the palettes are displayed, you need to turn them off for now by clicking the X in the top-right corner or by choosing Tools ➣ Palettes ➣ Tool Palettes from the menu bar. Your workspace might have different toolbars and palettes displayed than those shown in Figure 1.5. If other palettes are still visible, click the X in the upper-right or upper-left corner of each palette to close it.

**Figure 1.5:** The tool palettes
3. The large area in the middle of the screen is called the drawing area. It might need adjusting. Choose View ➞ Visual Styles ➞ 2D Wireframe.

4. Choose View ➞ 3D Views ➞ Plan View ➞ World UCS. If dots appear in the drawing area, the grid is turned on.

5. Move the cursor to the status bar at the bottom of the screen, and click the Grid readout button so it’s in the off (unpushed) position. Be sure all the other readout buttons except Model are in their off (unpushed) positions.

Your screen should look close enough to Figure 1.3 to continue. You’ll arrange the toolbars the way you need them a little later.

Introducing the AutoCAD Graphics Window

At the top of the graphics window sit the title bar, the menu bar, and three toolbars. You might have more or less than three toolbars; if so, you’ll change that soon.

The title bar is analogous to the title bar in any Windows program. It contains the program name (AutoCAD or AutoCAD LT) and the title of the current drawing with its path, as long as any drawing other than the default Drawing. dwg is open. Below the title bar is the menu bar, where you’ll see the drop-down menus. Among the drop-down menus, File, Edit, Window, and Help are standard Windows menus (meaning that they appear on Windows-compliant applications). These Windows menus also contain a few commands specific to AutoCAD. The rest of the menus contain AutoCAD-specific functions.

To the far right of the menus are the InfoCenter, Communications Center, and Favorites buttons. You can enter a question in the field to the left of the InfoCenter button to quickly access information from the Help system through the InfoCenter’s drop-down panel. With the Communications Center you can determine what type of information, such as software updates, product support, or RSS feeds, Autodesk sends directly to your system.
Below the menus are the *Standard* and *Styles toolbars*. The Standard toolbar contains 25 commonly used command buttons (LT has only 23). Several of these buttons will be familiar to Windows users; the rest are AutoCAD commands. The Styles toolbar to the right defines the appearance of any new objects in the drawing. Just below these toolbars are the *Workspaces*, *Layers*, and *Properties toolbars*, which together contain six command buttons and six drop-down lists.

The blank middle section of the screen is called the *drawing area*. Notice the movable *crosshair cursor*. The crosshairs on your cursor might not extend completely across the screen. Later in this chapter I will show you how to modify the length of the crosshairs as well as make a few other changes. Your screen might or might not display the coordinate tooltips next to the intersection of the crosshairs.

Notice the little box at the intersection of the two crosshair lines. This is one of several forms of the AutoCAD and LT cursor. When you move the cursor off the drawing area, it changes to the standard Windows pointing arrow. As you begin using commands, it will take on other forms, depending on which step of a command you’re performing.

The icon with a double arrow in the lower-left corner of the drawing area is the *UCS icon* (UCS stands for *user coordinate system*). It indicates the positive direction for the X and Y coordinates. You won’t need it for most of the chapters in this book, so you’ll learn how to turn it off in Chapter 3.

At the bottom of the drawing area are three tabs: a Model tab and two Layout tabs. You use these tabs to switch between viewing modes. (I’ll discuss viewing modes in Chapter 13.) This example shows no toolbars floating in the drawing area, but one toolbar is docked on either side of the drawing area. Your screen might or might not have the toolbars, or they might be in different positions. If the toolbars are floating within the drawing area, rather than docked along one edge, they will have a colored title bar. For specifics, see the section “Using the Toolbars” later in this chapter.
Below the drawing area is the **Command window**.

When you enter commands, rather than using the menus or buttons, the Command window is where you tell the program what to do and where the program tells you what’s happening. It’s an important area, and you’ll need to learn how it works in detail. Two lines of text should be visible. You’ll learn how to increase the number of visible lines later in this chapter in the section “Working in the Command Window.”

Below the Command window is the **status bar**.

On the left end of the status bar, you’ll see a coordinate readout window. In the middle are 10 readout buttons (LT has only 9) that indicate various drawing modes. It’s important to learn about the coordinate system and most of these drawing aids (Snap, Grid, Ortho, and Osnap) early on as you learn to draw in AutoCAD or LT. They will help you create neat and accurate drawings. Polar and Otrack are advanced drawing tools and will be introduced in Chapter 5. Ducs stands for **Dynamic User Coordinate System**; it’s used in 3D drawings. Dyn is an off/on toggle that activates or suppresses the dynamic display of information next to the crosshair cursor when it’s in the drawing area. For now, keep it in the off (unpushed) mode. Lwt (which stands for **lineweight**) will be discussed in Chapter 14. The Model button is an advanced aid that I’ll cover in Chapter 13. At the far right of the status bar are tools for controlling the appearance of annotation objects in AutoCAD. The padlock icon controls which types of toolbars and windows are locked in their current positions on the screen. Leave it in the unlocked mode for now.

This has been a quick introduction to the various parts of the graphics window. I didn’t mention a couple of items that might be visible on your screen. You might have scroll bars below and to the right of the drawing area; although these can be useful, they can take up precious space in the drawing area. They won’t be of any use while working your way through this book, so I suggest you remove them for now.

To temporarily remove these features, follow these steps:

1. Choose Tools ➔ Options to open the Options dialog box (shown in Figure 1.6). It has 10 tabs (LT has only 8) across the top that act like tabs on file folders.
2. Click the Display tab, which is shown in Figure 1.7. Focus on the Window Elements section. If scroll bars are visible on the lower and right edges of the drawing area, the Display Scroll Bars In Drawing Window check box will be selected.
3. Click the check box to turn off the scroll bars. Also be sure the check box for Display Screen Menu is not selected. Don’t click the OK button yet.

Another display setting that you might want to change at this point controls the color of the cursor and the drawing area background. The illustrations in this book show a white background and black crosshair cursor, but you’re probably seeing the AutoCAD default, which features a black background and a white crosshair cursor. If you want to change the colors, follow these steps:

1. In the Window Elements area of the Display tab, click the Colors button to open the Drawing Window Colors dialog box (see Figure 1.8). In the upper-left corner of the dialog box, in the Context list box, 2D Model Space should be selected. If it’s not, select it.

![Figure 1.8: The Drawing Window Colors dialog box](image)

2. Move to the Color drop-down list, which is in the upper-right corner. If your drawing area background is currently white, a square followed by the word *White* is displayed. Open the Color drop-down list, and select Black (or the background color you want). The drawing area will now be that color, and the cursor color will change to white, as shown in the Preview window below.

3. Click the Apply & Close button to close the Drawing Window Colors dialog box. The background and cursor colors change.
4. Don’t close the Options dialog box yet.

5. If you want the lines of your crosshair cursor to extend completely across the screen, go to the lower-left corner of the Display tab (the lower-right corner for LT), and move the slider to change the Crosshair Size setting to 100.

6. Click OK to apply any remaining changes and close the Options dialog box.

Your crosshair lines now extend across the drawing area.

**TIP** If you choose a color other than black as the drawing area background color, the color of the crosshair cursor remains the same as it was. To change the crosshair color, in the Drawing Window Colors dialog box, go to the Interface Element list box, and select Crosshairs. Then, select a color from the Color drop-down list.

**Working in the Command Window**

Just below the drawing area is the Command window. This window is separate from the drawing area and behaves like a Windows window—that is, you can drag it to a different place on the screen and resize it, although I don’t recommend you do this at first. If you currently have fewer than three lines of text in the window, you’ll need to increase the window’s vertical size. To do so, move the cursor to the horizontal boundary between the drawing area and the Command window until it changes to an up-and-down arrow broken by two parallel horizontal lines.

Hold down the left mouse button, drag the cursor up by approximately the amount that one or two lines of text would take up, and then release the mouse button. You should see more lines of text, but you might have to try this a couple of times to display exactly three lines. A horizontal line will separate the top two lines of text from the bottom line of text. When you close the program, AutoCAD will save the new settings; the next time you start AutoCAD, the command window will display three lines of text.

The Command window is where you give information to AutoCAD and where AutoCAD prompts you for the next step in executing a command. It’s good practice to keep an eye on the Command window as you work on your drawing. Most errors occur when you aren’t looking at it frequently. If the Dyn button on the
status bar is in the on position, some of the information in the Command window will appear in the drawing area next to the cursor. I’ll cover this feature when you start drawing.

Before you begin to draw, take a close look at the menus, toolbars, and keyboard controls.

**NOTE** In many cases, you can start AutoCAD commands in a number of ways: from drop-down menus, from the toolbars, from the Command window, and from menus that appear when you right-click. When you get used to drawing with AutoCAD, you’ll learn some shortcuts that start commands quickly, and you’ll find the way that is most comfortable for you.

**Using the Drop-Down Menus**

The left end of the menu bar, just below the title bar (see Figure 1.3 earlier in this chapter), consists of an icon and 11 (12 if you have the Express Tools installed) words. Click any of these to display a drop-down menu. The icon and the File and Edit menus are included with all Windows-compliant applications, although they are somewhat customized to work with AutoCAD. The drop-down menu associated with the icon contains commands to control the appearance and position of the drawing area.

Commands in the File menu are for opening and saving new and existing drawing files, printing, exporting files to another application, choosing basic utility options, and exiting the application. The Edit menu contains the Undo and Redo commands, the Cut and Paste tools, and options for creating links between AutoCAD files and other files. The Help menu works like most Windows Help menus and contains a couple of AutoCAD-specific entries as well, including some online resources and a link to the New Features Workshop.

The other eight (or nine) menus contain the most often used AutoCAD commands. You’ll find that if you master the logic of how the commands are organized by menu, you can quickly find the command you want. Here is a short description of each of the other AutoCAD drop-down menus:

**View** Contains tools for controlling the display of your drawing file.

**Insert** Contains commands for placing drawings and images or parts of them inside other drawings.

**Format** Contains commands for setting up the general parameters for a new drawing or changing the entities in a current drawing.
Tools  Contains special tools for use while you’re working on the current drawing, such as those for finding the length of a line or for running a special macro.

Draw  Contains commands for creating new objects (such as lines or circles) on the screen.

Dimension  Contains commands for dimensioning and annotating a drawing.

Modify  Contains commands for changing existing objects in the drawing.

Window  Contains commands for displaying currently open drawing windows and lists currently open drawing files.

Express  Contains a library of productivity tools that cover a wide range of AutoCAD functions. Express Tools are widely used but unsupported directly by Autodesk. They might or might not be installed on your computer.

Using the Toolbars

Now look at the toolbars on your screen. You’ll have two to five toolbars in one or two rows at the top and a couple more on the right and/or left sides of the drawing area. Just below the drop-down menus is the most extensive of the toolbars—the Standard toolbar.

The icons on the AutoCAD toolbars look like flat images and don’t appear as raised buttons until you point to them. The Standard toolbar has 25 icons, and they are arranged into 7 logical groups. The icons on the left half of the Standard toolbar are mostly for commands used in all Windows-compatible applications, so you might be familiar with them. The icons on the right half of the Standard toolbar are AutoCAD commands that you use during your regular drawing activities. You use these commands to take care of a number of tasks, including the following:

- Changing the view of the drawing on the screen
- Changing the properties of an object, such as color or linetype
- Borrowing parts of an unopened drawing to use in your current drawing
- Displaying a set of palettes that contain objects you can use in your drawing

LT has only 23 Standard toolbar buttons. It’s missing the Sheet Set Manager and Block Editor buttons because LT doesn’t offer these features.
Accessing the Toolbar Fly-Out Menus

Notice that one icon on the Standard toolbar has a little triangular arrow in the lower-right corner. This arrow indicates that clicking this icon displays more than one command. Follow these steps to see how this special icon works:

1. Move the cursor to the Standard toolbar, and point to the icon that has a magnifying glass with a rectangle in it.

2. Rest the arrow on the button for a moment without clicking. A small window opens just below it, displaying the command the button represents. In this case, the window should say **Zoom Window**. This is a *tool tip*—all buttons have them. Notice the small arrow in the lower-right corner of the icon. This is the multiple-command arrow mentioned earlier.

3. Place the arrow cursor on the button, and hold down the left mouse button. A column of nine buttons opens vertically below the original button (see Figure 1.9). The top button in the column is a duplicate of the button you clicked. This column of buttons is called a *toolbar fly-out menu*. In this example, you’re working with the Zoom toolbar fly-out menu.

4. While still holding down the mouse button, drag the arrow down over each button until you get to the one that has a magnifying glass with a piece of white paper on it. Hold the arrow there until you see the tooltip. It should say **Zoom All**. Now release the mouse button. The fly-out menu disappears, and AutoCAD executes the **Zoom All** command. Look in the Command window at the bottom of the screen.

The Zoom All command changes the view of your drawing to include special preset parameters. You’ll look at this command in Chapter 3.
At the end of the top line of text is _a11. This tells you that you have used the All option of the Zoom command. This fly-out menu is called the *Zoom fly-out menu* because it contains tools for changing views of the drawing, or “zooming around in the drawing.”

5. Look at the Standard toolbar where the Zoom Window button was previously. Notice that the Zoom All button has replaced it.

**T I P** On a toolbar fly-out menu, the button you select replaces the button that was on the toolbar. This arrangement is handy if you’re going to be using the same command several times, because the button for the command is readily available and you don’t have to open the fly-out menu to select it again. The order of the fly-out menu buttons remains the same, so when you open the Zoom fly-out menu again, the Zoom Window button will be at the top of the list. You’ll need to become familiar with any fly-out menu buttons you use, because the last one used becomes the representative button on the toolbar.

The behavior of the Zoom fly-out menu on the Standard toolbar is the same as the behavior of fly-out menus in general.

**N O T E** Whenever you start AutoCAD or LT for a new drawing session, the toolbars are reset and contain the original fly-out menu buttons.

The toolbar fly-out menus are regular toolbars that have been attached to another toolbar. AutoCAD has 37 toolbars in all, but only a few have fly-out menus—the Zoom fly-out menu I just discussed and the Insert fly-out menu on the Draw toolbar, for example. You can display the Zoom and Insert fly-out menus as regular toolbars, independent of the Standard and Draw toolbars.

**Displaying and Arranging Toolbars**

In this section, I’ll use the Zoom toolbar to show you some ways you can control and manipulate toolbars. Follow these steps:

1. Be sure the padlock icon in the lower-right corner of your screen is in unlocked mode. Then, right-click any toolbar button on the screen to open the Toolbars menu (see Figure 1.10).
2. If you don’t see Zoom near the bottom of the list, you should have a down arrow there. Use it to scroll down, if necessary, and then click Zoom to display the Zoom toolbar in the form of a floating box in the drawing area.

Notice that the Zoom toolbar now has a title bar. Toolbars that are positioned on the drawing area are called floating toolbars. They have title bars; and by placing the cursor on the title bar and holding down the left mouse button, you can drag the toolbar around the screen. Try this with the Zoom toolbar.

3. Drag the Zoom toolbar to the right side of the screen. You’ll notice that as you drag it, the toolbar stays put, and you’re dragging a rectangle of the same size as the toolbar (see Figure 1.11). As you drag the rectangle to the right of the drawing area and begin to move it off the drawing area onto the right side of the screen, the rectangle becomes taller and thinner.
4. Once the rectangle has changed shape, release the left mouse button. The rectangle changes to the Zoom toolbar, which is now positioned off the drawing area without its title bar.

This procedure is called *docking* a toolbar. Notice how the Standard and other toolbars at the top of the drawing area have no title bars—they are docked.

Continue with these steps:

1. Drag the Zoom toolbar back onto the drawing area, using the grab bars at the top of the toolbar. You can easily change the shape of any floating toolbar by dragging its edge. Let’s change the shape of this toolbar.

2. Move the cursor to the far-right edge of the Zoom toolbar until the crosshair cursor changes to a two-way arrow.
Hold down the left mouse button with the cursor on the right edge of the toolbar, and drag the arrow to the left until the rectangle changes shape. Release the mouse button.

You can reshape and reposition each floating toolbar to fit on the drawing area just as you want it. You won’t need the Zoom toolbar just now, so you’ll remove it.

3. Move the cursor to the title bar, and click the box with an X in it to close the Zoom toolbar.

Floating toolbars don’t affect the size of the drawing area, but they cover your drawing. Each row or column of docked toolbars takes up space that would otherwise be drawing area. You have to decide how many docked and floating toolbars you need on the screen at a time. A good way to start is to leave the Standard, Layers, and Properties toolbars docked on the top of the screen and the Draw and Modify toolbars docked on the left side of the screen.

If your toolbars are positioned as shown in Figure 1.12, continue with the next section. If these toolbars are in another location on the drawing area or not visible, try the steps you used in this section to dock them on the top and left sides of the drawing area. If the toolbars aren’t visible, right-click any visible toolbar button, and choose the toolbar you need. Then, drag the toolbar to the left side or top of the drawing area to dock it. Here are the positions I recommend for the five toolbars you should dock on your screen:

- At the top, just under the menu bar, dock the Standard toolbar.
- Below that, on the left side, dock the Layers toolbar.
- To the right of the Layers toolbar, dock the Properties toolbar.
- On the left side, dock the Draw toolbar.
- Next to the Draw toolbar, dock the Modify toolbar.
This arrangement of the toolbars will be convenient because you'll often use commands on these five toolbars. When you need other toolbars temporarily, you can use the Toolbars menu to display them in the drawing area and let them float. If you have any other toolbars docked on the screen, use their grab bars to drag them onto the screen. Then, click the Xs in their title bars to close them. Here is a partial list of toolbars that you might have on your screen that need to be turned off:

- Display Order toolbar
- Styles toolbar
- Workspaces toolbar
Customizing Toolbars

You can customize each toolbar, and you can build your own custom toolbars to display only the buttons you use frequently. You can even design your own buttons for commands that aren’t already represented by buttons on the toolbars. These activities are for more advanced users, however, and aren’t covered in this book. To find out more about how to customize toolbars, see Mastering AutoCAD 2008 and AutoCAD LT 2008 by George Omura (Wiley, 2007).

Workspaces

Now that you have your screen set up to look like Figure 1.3, you are ready to proceed through the book. I’ll direct you to display additional toolbars as needed. For now, though, save this setup as a new workspace because it’s a variation of the AutoCAD Classic or LT workspace that comes with the program. Follow these steps:

1. Choose Tools ➢ Workspaces ➢ Save Current As. This opens the Save Workspace dialog box (see Figure 1.13).

![Figure 1.13: The Save Workspace dialog box](image)

2. Enter 2D Drawing, and click Save. The computer works for a while and then returns you to your workspace. The new 2D Drawing workspace setup will remain as it now is until you change it or until you select a different workspace.

3. Right-click any toolbar, and click the Workspaces entry in the Toolbars list; you’ll see the 2D Drawing workspace displayed in the Workspaces toolbar below 2D Drafting & Annotation, 3D Modeling, and AutoCAD Classic (see Figure 1.14). Later in this book, AutoCAD users will switch to the 3D Modeling workspace and make a few adjustments to it.
4. Close the Workspaces toolbar.

When you make changes to the new workspace—by adding a toolbar or changing the background color of the drawing area—you can easily update the 2D Drawing workspace to accommodate those changes. Follow steps 1 and 2 previously, naming the workspace again to 2D Drawing. You’ll get a warning window telling you that a workspace by that name already exists and asking you whether you want the new arrangement to replace the old one. Click Yes.

**Using the Keyboard**

The keyboard is an important tool for entering data and commands. If you’re a good typist, you can gain speed in working with AutoCAD by learning how to enter commands from the keyboard. AutoCAD provides what are called *alias keys*—single keys or key combinations that start any of several often used commands. You can add more or change the existing aliases as you get more familiar with the program.

In addition to the alias keys, you can use several of the F keys (function keys) on the top row of the keyboard as two-way or three-way toggles (switches) to turn AutoCAD functions on and off. Although buttons on the screen duplicate these functions (Snap, Grid, and so on), it’s sometimes faster to use the F keys.

Finally, you can activate commands on the drop-down menus from the keyboard, rather than by using the mouse. If you press the Alt key, an underlined letter, called a *hot key*, appears on each menu. Pressing the key for the underlined letter activates the menu. Each command on the menu also has a hot key. Once you activate the menu with the hot-key combination, you can enter the underlined letter of these commands. For a few commands, this method can be the fastest way to start them and to select options.
While working in AutoCAD, you’ll need to enter a lot of data, such as dimensions and construction notes; answer questions with “yes” or “no”; and use the arrow keys. You’ll use the keyboard constantly. It might help to get into the habit of keeping your left hand on the keyboard and your right hand on the mouse if you’re right-handed, or the other way around if you’re left-handed.

**Using the Mouse**

Your mouse most likely has two buttons and a scroll wheel. So far in this chapter, you have used the left mouse button for choosing menus, commands, or options or for holding down the button and dragging a menu, toolbar, or window. The left mouse button is the one you’ll be using most often, but you’ll also be using the right mouse button.

While drawing, you’ll use the right mouse button for the following three operations:

- To display a menu containing options relevant to the particular step you’re in at the moment
- To use in combination with the Shift or Ctrl key to display a menu containing special drawing aids called *object snaps* (see Chapter 10)
- To display a menu of toolbars when the pointer is on any icon of a toolbar that is currently open

If you have a three-button mouse, the middle button is usually programmed to display the Object Snap menu, instead of using the right button with the Shift key. If you have a mouse with a scroll wheel, you can use the wheel in several ways to control the view of your drawing. I’ll cover those methods in subsequent chapters.

AutoCAD makes extensive use of toolbars and the right-click menu feature. This makes your mouse an important input tool. The keyboard is necessary for inputting numeric data and text, and it has hot keys and aliases that can speed up your work; however, the mouse is the primary tool for selecting options and controlling toolbars.

The next chapter will familiarize you with a few basic commands that will enable you to draw a small diagram. If you want to take a break and close AutoCAD, choose File ➞ Exit, and choose not to save the drawing.
Are You Experienced?

Now you can...

✓ recognize the elements of the AutoCAD graphics window
✓ understand how the Command window works and why it’s important
✓ use drop-down menus
✓ open and control the positioning of toolbars
✓ save a workspace of your screen setup in AutoCAD